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INSTRUCTIONS & INSTALLA

EXTRA! EXTRA!

EXTRA!

Publishers Unite!

You Benefit

Dear CD-ROM Enthusiast:

Congratulations on your purchase of Volume 2 of “The
Original 5ft. 10 PAK™” Once again, Sirius Publishing intro-
duces you into the exciting world of multimedia at a
breakthrough price.

In the same tradition of Volume 1, this NEW volume
packs 10 CD’s of fun and entertainment into one incred-
ibly priced collection. Like its predecessor, Volume 2

transports you to multimedia’s galaxies of entertainment,

games, reference, animation and more. It truly provides

you with hours of computing fun.

This is no gimmick! In an effort to introduce you to
their titles, the software publishers featured here have
joined together to provide you with a total multimedia
experience — and you win! That's right, you benefit. This
is your opportunity to explore multimedia and quickly
build a CD-ROM library — all at a tremendous value.

Plus, we’ve included more than $100.00 in software
coupons so you can try our other fine titles and continue
adding to your collection. Sirius Publishing also helps

you get “connected” by including 10 free hours of
PRODIGY online service. Don’t wait any longer. Break
open your bundle, power up your PC and experience
multimedia at its best.

Cordially,

/

Richard Gnant, President



INSTRUCTIONS FOR SIRIUS PUBLISHING VERSION 4.0

I . e

-

PC KARAOKE FAMILY FUN ] OK, Richard!
"kt srespacd oo gevt o' e compor stoppes | | 1101501 ... SOId ... SOLDI!
A i s zz:rr.:’:z:g;k::rz,-::f;:n:; sistawsws | 1 You turn out the best 10 CD-ROM
AR e ke e s @y Bundles available anywherel Your
g ieEEsmmmm. . OpL o o bowme sl
e L A e Sbother writing me about every new
e iemcimeen, M| 1 SFT. 10 PAK". Don't phone m, Just
‘?-? eatte ot o e s e lmeeone s | 3 send it fo me AUTOMATICALLY and
the Exit Buion o the main window. charge my Bank Card (see back)
$29.95 plus $4.00 shipping and
handling after it’s shipped. If
I'm not delighted, I'll send
it back for a full credit

refund within 10 days
— GUARANTEED !!!

MIXER CONTROLS

PC Karaoke directly links to many sound cards so you have access to volume controls within the program.
To run the PC Karaoke mixer, select the Mixer Button in the lower left corner of the main window. If a
message appears at the bottom that says “THE SOUND CARD YOU HAVE CHOSEN DOES NOT
SUPPORT INTERNAL MIXER CONTROLS", simply use the scroll arrows next to Unlisted Sound Card to
select the sound card which your system supports. When the above message disappears, you will have
access to microphone levels and volume controls from within PC Karaoke. Once the mixer control is
set-up, the “ & ” and “ & " keys will control the master volume.

PUBLISHINC
INCORPORATED

If you have multiple PC Karaoke CD's and wish to switch song discs, simply
stop the current song and eject the disc from the drive when you're at the
main window. The computer will prompt you to insert the new song disc.

Many systems do not have their MCI CD-Audio drivers automatically installed
when the CD-ROM is installed. This will appear as a MCI error of varying types.
To install it, use the Drivers icon under the Control Panel in the Main program
group Select [Add] and highlight [MCI] CD-Audio. Click [OK] and follow the

Lt o dss e e vin s - s o - el



gs Subject
to Change

SONG TITLE

Along Comes Mary
Always And Forever

Drift Away

Joy To The World

In This Life

More Than Words

Rainy Days And Mondays
Run To You

Sittin’ On The Dock Of The Bay
You Are So Beautiful

3000

SONG TITLE

New York, New York

Friends In Low Places

Oh, Pretty Woman
Unforgettable

You‘ve Lost That Lovin‘ Feelin’
Crazy

How Will | Know

Can’t Help Fallin’ In Love
Everything | Do (I Do It For You)
Twist & Shout

3005

SONG TITLE

Achy Breaky Heart
Could've Been Me

Forever And Ever Amen
Forever’s As Far As I'll Go
If | Didn‘t Have You

In This Life

Love’s Got A Hold On You
Midnight In Montgomery
So Much Like My Dad

3007

SONG TITLE
Are You Lonesome Tonight?
Heartbreak Hotel

Hound Dog

It's Now Or Never
Jailhouse Rock

Love Me Tender

Teddy Bear

Return To Sender

Blue Hawaii

All Shook Up

3008

SONG TITLE

Come See About Me

Do You Want To Know A Secret
Great Pretender (The)

| Heard It Through The Grape Vine
I‘m Walkin’

Louie Louie

Rock Around The Clock

Wooly Bully

You Can’t Hurry Love

You've Really Got A Hold On Me

To order Sing-Along CD titles, Dial 1-800-247-0307 ™

PC KARAOKE SING-ALONG SONG LIST

IN THE STYLE OF
The Association
Ashford & Simpson
Dobie Grey
Three Dog Night
Collin Raye
Extreme
Carpenters

Bryan Adams
Otis Redding

Joe Cocker

Original Hits

IN THE STYLE OF
Frank Sinatra
Garth Brooks

Roy Orbison

Nat King Cole
The Righteous Brothers
Patsy Cline
Whitney Houston
Elvis Presley
Bryan Adams

The Beatles

Cowboy Country

IN THE STYLE OF
Billy Ray Cyrus

Billy Ray Cyrus
Randy Travis
Alabama

Randy Travis

Collin Raye

Alan Jackson

Alan Jackson

George Strait

There Ain't Nothing Wrong With The Radio  Aaron Tippin

Elvis (The King)

IN THE STYLE OF
Elvis Presley
Elvis Presley
Elvis Presley
Elvis Presley
Elvis Presley
Elvis Presley
Elvis Presley
Elvis Presley
Elvis Presley
Elvis Presley

Livin’ In The Sixties

IN THE STYLE OF
Supremes

The Beatles

The Platters

Marvin Gaye

Fats Domino

Kingsmen

Bill Haley & The Comets
Sam The Sham & the Pharaohs
Supremes

Miracles

Broadway’s Best

3010

SONG TITLE

Climb Ev’ry Mountain
Edelweiss

If | Loved You

If | Wete A Rich Man
Match Maker, Match Maker
Put On A Happy Face
Some Enchanted Evening
Something Good

Sunrise, Sunset

Younger Than Springtime

SONG TITLE

Do | Have To Say The Words
End Of The Road

| Don’t Have The Heart

Into The Great Wide Open

| Will Be Here For You
Learning To Fly

Man In The Mirror

More Than Words

Restless Heart

The Way You Do The Things You Do

Lovin’ In The
3015

SONG TITLE

Along Comes Mary

Baby Love

Chamé',y Lace

Misty

My Guy

Only You

Please Mr. Postman
Stand By Me

Where Did Our Love Go
Will You Still Love Me Tomorrow

3016

SONG TITLE
Here | Go Again
Its Not Over (‘Til It's Over)
Jacob’s Ladder

Mustang Sally

My Generation

Old Time Rock and Roll
She’s A Beauty

Signs

Wanted Dead Or Alive
When Will | Be Loved

Rock On!°

IN THE STYLE OF
Sound Of Music
Sound Of Music
Carousel

Fiddler On The Roof
Fiddler On The Roof
Bye Bye Birdie
South Pacific

Sound Of Music
Fiddler On The Roof
South Pacific

IN THE STYLE OF
Bryan Adams
Boyz Il Men
James Ingram
Tom Petty
Michael W, Smith
Tom Petty
Michael Jackson
Extreme

Peter Cetera
UB40

Sixties

IN THE STYLE OF
The Association
Supremes

The Big Bopper
Johnny Mathis
Mary Wells
The Platters
Marvelettes
Ben E. King
Supremes
Shirelles

IN THE STYLE OF
White Snake
Starship

Huey Lewis & The News
The Commitments
The Who

Bob Seger

The Tubes

Tesla

Bon Jovi

Linda Rondstadt

Remarkable Remakes

3017

SONG TITLE

Boogie Woogie Bugle Boy

Cathy’s Clown

(Sittin” On The) Dock Of The Bay
Drift Away

Light My Fire

Loco-Mation

My Girl

Oh Girl

Shoop Shoop Song (It's In His Kiss)
What Becomes Of The Broken Hearted

IN THE STYLE OF
Bette Midler
Reba McEntire
Michael Bolton
Dobie Grey
The Doors
Kylie Minogue
Temptations
Paul Young
Cher

Paul Young



SONG TITLE
9to 5 Dolly Parton

IN THE STYLE OF

Could | Have This Dance Anne Murray
Don’t It Make My Brown Eyes Blue Crystal Gayle
Girl’s Night Out The Judds
Grandpa (Tell Me About The Good Old Days) The Judds

I Just Fall In Love Again Anne Murray
Rockin’ With The Rhythm Of The Rain The Judds

She’s In Love With The Boy Trisha Yearwood
That’s What | Like About You Trisha Yearwood
You Needed Me Anne Murray

Jukebox Diner

3020

SONG TITLE IN THE STYLE OF
Sixteen Candles The Crests

Blue On Blue Bobby Vinton
Dream Lover Bobby Darin

Go Away Little Girl
1 Will Follow Him

Steve Lawrence
Little Peggy March

Little Darlin’ The Diamonds
Roses Are Red (My Love) Bobby Vinton
Stardust Standard
Unicorn Irish Rovers

Kisses Sweeter Than Wine Jimmie Rodgers

Christmas For Kids Of All Ages

3021

SONG TITLE IN THE STYLE OF
Deck The Halls Traditional
Frosty The Snowman Traditional
Here Comes Santa Claus Traditional
Silver And Gold Traditional
Jingle Bells Traditional
Rudolph The Red-Nosed Reindeer  Traditional
Santa Claus Is Coming To Town Traditional
The Twelve Days Of Christmas Traditional
Up On The House Top Traditional

When Santa Claus Gets Your Letter Traditional

Christmas Classics
3022

SONG TITLE IN THE STYLE OF
Blue Christmas Traditional
| Heard The Bells On Christmas Day Traditional

God Rest Ye Merry Gentlemen Traditional
Have Yourself A Merry Little Christmas ~ Traditional
A Holly Jolly Christmas Traditional
Toyland Traditional
We Wish You A Merry Christmas Traditional
What Child Is This Traditional
Winter Wonderland Traditional

It's The Most Wonderful Time Of The Year Traditional

The Christmas Spirit

3023

SONG TITLE IN THE STYLE OF
Away In A Manger Traditional
The First Noel Traditional
Hark The Herald Angels Sing Traditional
It Came Upon A Midnight Clear Traditional
Joy To The World Traditional
O Holy Night Traditional
O Little Town Of Bethlehem Traditional
Oh Come All Ye Faithful Traditional
Silent Night Traditional

We Three Kings Of Orient Are Traditional

SONG TITLE

Carol Of The Bells

Good King Wenceslas

I’ll Be Home For Christmas

Let It Snow, Let It Snow, Let It Snow

Nuttin’ For Christmas
Oh Christmas Tree
Silver Bells

Sleigh Ride

White Christmas

IN THE STYLE OF
Traditional
Traditional
Traditional
Traditional
Traditional
Traditional
Traditional
Traditional
Traditional

Rockin’ Around The Christmas Tree Traditional

Love Songs (50s-60s)

3026

SONG TITLE

All I Have To Do Is Dream
Blue Velvet

Cherish

Love Letters In The Sand

Never Be Anyone Else But You

Puppy Love
Sealed With A Kiss
Twilight Time
Turn, Turn, Turn
Till | Kissed You

3030

SONG TITLE
Candle In The Wind
For Once In My Life
Hello Again

| Just Called To Say | Love You

The Last Song

Send One Your Love
Song Sung Blue
You've Got A Friend
Your Song

Whiter Shade Of Pale

SONG TITLE

Alfie

Days Of Wine & Roses
From A Distance

The Girl From Ipanema

| Left My Heart In San Francisco
| Write The Songs
Love Is A Many Splendored Thing
People

Somewhere My Love
Sweet Caroline

SONG TITLE
After All
Don‘t Know Much

Don‘t Let The Sun Go Down On Me

Next Time | Fall In Love
Guilty
Somewhere Out There

I've Had The Time Of My Life

You Don‘t Bring Me Flowers
Tonight | Celebrate My Love

Nobody Loves Me Like You Do

Standards (Old and New)

3032

Du-et Now

3036

IN THE STYLE OF
Everly Brothers
Bobby Vinton
The Association
Pat Boone
Ricky Nelson
Paul Anka
Bobby Hyland
The Platters
The Byrds
Everly Brothers

Spanning The Decades (70s-80s-90s)

IN THE STYLE OF
Elton John
Steve Wonder
Neil Diamond
Steve Wonder
Elton John
Steve Wonder
Neil Diamond
James Taylor
Elton John
Procol Harum

IN THE STYLE OF
Alfie

Andy Williams
Bette Midler
Carlos Jobiem
Tony Bennett
Barry Manilow
Traditional
Barbra Streisand
Dr. Zhivago
Neil Diamond

IN THE STYLE OF
Cetera & Cher
Ronstadt & Neville
Elton John & George Michael
Grant & Cetera
Streisand & Gibb
Ingram & Ronstadt
Warnes & Medley
Streisand & Diamond
Bryson & Flack
Murray & Loggins



Fireside Love Songs (70s-80s)

3038
SONG TITLE IN THE STYLE OF
After The Lovin’ Engelbert Humperdinck
Always & Forever Heatwave
How Sweet It Is (To Be Loved By You) James Taylor ATTE N I N
| Honestly Love You Olivia Newton-John

If Bread

Mandy Barry Manilow so FTWARE
We've Only Just Begun The Carpenters

You Light Up My Life Debbie Boone

You Are So Beautiful Joe Cocker D EVE lo PE Rs
When Will | Be Loved Linda Ronstadt

Classic Oldies If you have a hot

3041
SONG TITLE IN THE STYLE OF f'? W Pfﬂgfﬂlll,
Danny Boy Traditional e
Forty-Five Minutes From Broadway Traditional s'r'us PUb"s,"ng
Harrigan Traditional
MacNamara‘s Band Traditional We'COmes new
Mary‘s A Grand Old Name Traditional ° °
My Wild Irish Rose Traditional Mu,"med'a
Over There Traditional
When Irish Eyes Are Smiling Traditional Au'hors.
Yankee Doodle Boy Traditional
You're A Grand Old Flag Traditional

If you would like to see
your product represented
in the next 5ft.10 PAK",

SONG TITLE IN THE STYLE OF please contact Sean Alan
Amazing Grace deft?onal af Sirius Pub"s’"'ng, Inc.
Camptown Races Traditional

Battle Hymn Of The Republic Traditional

He's Got The Whole World In His Hand Traditional

Home On The Range Traditional

My Bonnie Traditional

Oh, Susanna Traditional

On Top Of Old Smokey Traditional

Michael, Row Your Boat Ashore Traditional

Yellow Rose Of Texas Traditional
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Sales (800) 247-0307
Sales Fax (602) 951-3884
Tech Support (602) 951-8405

INSTRUCTIONS FOR

PRODIGY

sescesssee sevee sesee

The PRODIGY® service is your dtmcf connection to more people, more places, and
more fun. It's so easy. Just install the PRODIGY software and go. Whatever your
interest, the PRODIGY services gives you new ways fo make nearly everything you
do easier, faster, and more fun. The only way to appreciate the PRODIGY service is fo
experience it for yourself. You can be online in minutes, so go ahead — and start
getting more fun from your computer — and your life — today!

When you install PRODIGY from this disc, you receive 10 free hours of connect time
during your first month of membership.

» Make sure you have 3.5 MB of free hard disk space.

» Make sure you have a modem; your modem is turned on; your modem is
connected to a telephone line; and your modem supports baud rates between
2400 and 14,400 bps.

Insert PC Karaoke — Family Fun into your CD-ROM drive.

Under the Program Manager in Windows, select Run from the File menu.

Type D:\prodigy\prodins.exe where “D” is the letter of your CD-ROM drive.
Follow the on-screen instructions.

» Start the program by double-clicking the PRODIGY Software for Windows icon.

PRODIGY

»
>
>
>

The PRODIGY software will install the necessary software to log on to the PRODIGY service. Once
you've double clicked on the PRODIGY Software for Windows icon, double click on the | Would Like to
Connect to the PRODIGY system. Once you're connected to the Prodigy system, you will be asked to
supply information about yourself, then you will be assigned an account number and a password. You
will then be logged onto the PRODIGY Welcome Screen and you’ll be able to choose from the following
buttons :

NEWS/WEATHER: read Headline News for the top news stories. Check the latest Weather forecasts for
your town or virtually any city worldwide. Get a Close-up of today’s hot topics. Join Opinion Polls and let
your voice be heard. Keep fit with advice and reviews in Health News.

BUSINESS/FINANCE: use Quote Track to make informed decisions with continually updated stock quotes
throughout the day. Explore the financial world with Wall St. Edge, our digest of financial newsletters.
Consult online experts and other members on the Careers bulletin board. Use Strategic Investor, a compre-
hensive database of stocks and mutual funds. Do your banking at home with Banking Online.

SPORTS: catch the latest scoops, stats, and scores with Sports News. Compete with other golfers and play
America’s greatest courses on the PRODIGY Network Golf Tour. Shop Sports Saver for great deals on top
brand equipment. Take a swing at big-league games and contests in Sports Games. Talk with fellow enthu-
siasts on the Sports BB. Set up your own personalized sports pages with Sports Track. Let other fans know
what you think in our weekly Sports Survey.

COMMUNICATIONS: find the names of other members with the Member List. Visit the Board Center and
explore bulletin board topics. Communicate with top personalities in the Guest Spotlight.

ENTERTAINMENT: try the national trivia quiz you really need GUTS® to play. Match wits with the com-
puter and fellow members in a host of ('hﬂlengmg games in Game Center. Keep up with your favorite day-
time dramas with Soap Operas. Hear about the best music around with Music Reviews, Classical Music
and Music Charts. See what's in the stars for you with Horoscopes. Communicate with fellow friends and
fans on the TV Bulletin Board. Hear about the latest news and accolades first with Movie News & Views
and Awards. Catch up on your reading with Book Charts and Book Index.

REFERENCE: from big screen to video check out reviews of thousands of films in the Movie Guide. Sample
more than 3,000 recipes with an online Cookbook. Compare notes with other parents in the Education BB.
Check into the PRODIGY Inn Directory before you take that weekend getaway. Find the right program for
any computer task with our comprehensive Software Guide. Make informed decisions using a complete
and always up-to-date library of Consumer Reports articles.

SHOPPING: buy, sell, or trade with other members via the PRODIGY Classifieds. Remember important
dates with Gift Reminder. Shop some of America’s finest Discount Outlets without leaving home.

COMPUTERS: learn more about hardware, software, and more in Computer Basics. Let a nationally know
expert put the fast moving PC world with Magid on PCs. Exchange ideas with other members on the
Computer BB. Get the score with the hottest computer games with Gameware and the latest educational
programs with Schoolware. Talk with other members about business software, multimedia, peripherals,
and more on the Computer Support BB. Visit Ziffnet for latest news and reviews, and thousands of ready-
to-download programs. Learn more about the worldwide Electronic Highway on the Internet BB.

TRAVEL: use Easy Sabre to book the lowest available airfares and Easy Quiktix for free overnight ticket
delivery. Take an insiders look at major US cities before you visit them with City Guide and the Mobil
Travel Guide. Visit the Travel BB before you leave for helpful advice. Let the renowned Zagat’s Guide help
you choose the perfect restaurant in whatever city you happen to be visiting.

HOME/FAMILY/KIDS: communicate with other parents, pet owners, and others in the Homel:/e BB. Trace
your family tree with the help of Gormely on Genea/ogy Drop by This Old House. Use an Encyclopedia
with more than 30,000 articles. Visit online versions of the Baby-Sitter’s Club® and Sesame Street.
MEMBER SERVICES: select this button to reach Member Services. Here you can find new about upcoming
features, look into the latest pricing plans, get information about your account, and even make suggestions
about how we can better serve you.

Enjoy!
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#3022 Christmas Classics

Blue Christmas; | Heard The Bells On Christmas Day; God Rest
Ye Merry Gentlemen; Have Yourself A Merry Liftle Christmas; A
Holly Jolly Christmas; Toyland; We Wish You A Merry Christmas;
What Child Is This; Winter Wonderland; It's The Most Wonderful
Time Of The Year.
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Sirius Publishing, Inc.

PC KARAOKE
SING-ALONG ' . |

Sing the songs YOU like. Choosé.l\//f// i g
from any of the listed PC NS IRIUS|
Karaoke™ song discs and send us D
99¢ (plus shipping & handling). b
It's that simple. No gimmick, fio

catch, we just wantyou to belt -

out a tune and amaze your LT
friends. ¥ s
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This offer is valid ONLY on the listed fitles when you order by mail and
include the original coupon. Not Valid on phone, fax, or previous orders.
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#3021 Christmas For Kids Of All Ages

Deck The Halls; Frosty The Snowman; Here Comes Santa Claus;
Silver and Gold; Jingle Bells; Rudolph The Red-Nosed Reindeer;
Santa Claus Is Coming To Town; The Twelve Days Before; Up On
The House Top; When Santa Claus Gets Your Letter.
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#3023 The Christmas Spirit
Away In A Manger; The First Noel; Hark The Herald Angels Sing;
It Came Upon A Midnight Clear; Joy To The World; O Holy
Night; O Liftle Town Of Bethlehem; Oh Come All Ye Faithful;
Silent Night; We Three Kings.

#3024 Family Christmas
Carol Of The Bells; Good King Wenceslas; I’ll Be Home For
Christmas ; Let It Snow, Let It Snow, Let It Snow; Nuttin’ For
Christmas; Oh Christmas Tree; Silver Bells; Sleigh Ride; White
Christmas; Rockin’ Around The Christmas Tree.
- \\V 7 = > ¢
> o ‘&/{:“_\_/ ,b - \S/Zggtleies
( — ‘-.,l — ( ) L t
T = G
For multimedia holiday entertainment, this offer can’t be beat!
All 4 PC Karaoke Christmas discs are only $39.95 with this coupon.
They can also be used in your Audio CD player!
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Includes 600+ MB
‘ I PHB M ﬂ of Data & Visuals I I

| Receive 10 jewel cases for only |

For a complete sample display
listing of every font on 2000 fonts,

yrd buy the Fonts For You book. In N~
I addition, there are over 500 more "5"”6%’ I I
’ all original fonts available on the $97 $ 2 4 9 9 99 X
: Fonts For You CD which you can hile Su .
| I _ buy w:lh the book : \ ppl'%"‘“f I I
i I ? - P ar et * 01500+ Photos |I I
) 0 400 MB of videos, everything

} 1 3400 Mo videos vy ;
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, |_FONTS FOR YOU - BOOK & CD Analyzer atin
| and enjoy safe, clean s.tort,zge 1 300 Page 1 I} o risical Intelligence: Multiple 1 S;?gt;‘J 11
| Joryour O-ROMdiscst  p Bookand | TR [T =3t |

0 Thousands of entries in hypertex t]
PEEE I LIMIT ONE PER CUSTOMER I I

L SVI'I l INFOIM‘"ON ORDERING INFORMATION »




| SIRIUS PUBLISHIN

DNt
HICROPRONE

$20.95

lus Shipping & Handling

600 Ohm, Cannon
plug microphone with
18 ft. cord plus adapter
for your sound card.

G-I nRTS & LETTERS®

[l
[l

RRLAY S T07H ANTHOLOGY
SSIT COLLECTIN

410 GUNS 5l

JET FIGHTERS & BOMBERS FROM KOREA TO
DESERT STORM

= ?‘7
Create your own bw :
Korea to Desert Stonfn. In€lu

Stealth fighters and bomber

A\ (OI[['CTION OF l()

I I Extraordinary games from the 10 most
exciting and influential years in game
duelopment from Interplay loaded on to I
one CD-ROM. The games that'dominate
theaward listy exploréd new terrifory
and set the standard in the developing

I sounds and specifications of I I I industry include: I
top jets around the world. MINDSHADOW TAss
A lete d
i oo o] | | 3agms 0azz Tmes | |
and an on-line database DRAGON WARS WASTHANB
l while supplies last I l

Lord of the Rings ‘BattleChess

|
\
\
\
\
!
i
V
!
!
!
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|

100 % Money-back
Guarantee within 30 Days
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Castles

LT
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ICOM smuumoisijc i’af Trek 25th
ki nniversa
_I Sk REVERSE SIDE FOR ORDERING INFORMATION — e — -l L el N _QlﬂﬂHls_WL)RLD_l I




"PC NovicE

12 issues for only $24!

PC Novice magazine

is written in plain

EGRAPH‘S English for the
“"'-:'

| beginner compute!

—
1 ‘ user but contains

material for
everyone. It will
teach you things about your
computer you never knew
existed and offers upfo-date

information on the latest
breakthroughs in computer
technology.

Cancel anytime and receive a
refund for all unmailed issues

No Questions Asked!

Cover Price $2.95
12 issues x12

$35.40
32% savings -11.40

12 issues for $24.00
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I |
" DISC2 AND DISC3 o oo OFF I
(NOT AVAILABLE IN 3fr. 6 PAX)

I I A MULTIMEDIASAURUS OF ' ‘

FIRNGIALEING FUM!  SUGGESTED RETAIL

SEE REVERSE SIDE FOR RMATI
S e INFRMATION Il SEE _REVERSE SIDE FOR ORDER INFORMATION
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Please send me each new -|

5FT. 10 PAK” AUTOMATICALLY! |
To order by phone, call:

800-247-0307 |

or mail this coupon to: I
SIRIUS PUBLISHING
ATTN: Customer Service I

7320 E. Butherus Drive #100, Scottsdale, AZ 85260

ony $29.95 :

AZ Residents add 6.7% sales tax

Shipping & Handling S
et Tk

Total Due $

4.00
(10.00)

l Nome

I Address
(Ily SR P " i ~ Stte 7lip_ F
Payment . - u Aadi o s 24 2
T VisA OMC  CIDISCOVER  CICHECK 5
l At # Exp. Date
Signotre E— T  Phone

This offer is valid ONLY on the listed titles when you order by mail and
I include the original coupon. Not Valid on phone, fax, or previous orders.

SIRIUS PUBLISHING, INC.

7320 East Butherus Drive, Suite 100
Scottsdale, Arizona 85260

First Disc #
Check Addition Title

U2 3010&30!8&]302603041
300003014 3020 30300 3043
3005 30153022 (D 3032
3007 3016 3023 3036
3008 3017 3024 3038

Total Qty x$15.99=
Shipping & Handling

Outside the U.S. Shipping & Handli

i vy g, e b
Sales Tax (AZ residents—6.7%)

$0.99

$4.00
($10.00)

INSTRUCTIONS FOR MICROSOFT

MULTIMEDIA JUMPSTART

Messsscsesesanenssensansnseanes

B T P I R S R R R R R R O )

An informative disc on virtually every aspect of multimedia. Assembled by 'ho
Microsoft Multimedia Developer Relations Group, you’ll learn how develope:

integrate multimedia into everyday applications. You will also find useful fools like
the Video for Windows v1.1 SDK, sample media, and a host of technical articles full
of information and sample code.

» You may run the Multimedia Jumpstart CD without installing it to your hard
drive. Type D:\go.exe where “D” is the letter of your CD-ROM drive:

» Multimedia Jumpstart copies Visual Basic custom controls and DLL's into your
windows system directory. If you do not want this to happen, then run the
program from the CD-ROM.

o » Make sure you have 1 MB of free hard disk space.

» Insert the Multimedia Jumpstart CD into your CD-ROM drive.

» Under the Program Manager in Windows, select Run from the File menu.
» Type D:\ setup.exe where “D” is the letter of your CD-ROM drive.

» Follow the on-screen instructions.

» Start the program by double-clicking the Jumpstart Program icon.

Explore! Explore! Explore! You can spend hours with this disc without seeing the same thing twice. You
can use the Jumpstart Controller and Information Browser to view the various applications and tech notes
or you can search through the CD with the File Manager in Windows. While the Jumpstart Controller
and Information Browser are more convenient, the File Manager yields surprises unavailable under the
Jumpstart Controller. There is a lot of cool stuff on this disc! Amateur users and the technically proficient
alike can get an education from this CD. Don't be afraid to “play around” with it, you won't break
anything.

USING THE INFORMATION BROWSER AND JUMPSTART CONTROLLER.

Development: This button lists all the development articles on the CD.
Simply scroll down the list you see in the Jumpstart Controller

window and click on anything that interests you.

Sample Apps: The Sample Apps button references many of the sample
applications on the CD. Many other sample applications can
be accessed using the File Manager to browse the

d:\samp apps directory directly off the CD.

Sample Media: This button references some of the media clips available on
Jumpstart. Again, make sure you browse through the CD
directory using the File Manager to find even more clips to

sample. Look under the d:\samp med directory on the CD.

Allows you to browse through related topics you see in the
window of the Jumpstart Controller.

Search: If you can’t find what your looking for, try the full text search
feature in Jumpstart. This useful feature is available when you

author titles with Microsoft Multimedia viewer.

Help: The help button will provide a map of the directories on
Jumpstart. Click on any of the directories to find information

on what they contain.

Always in front On/Off: This toggles between the controller being always in
front or, if you wish it not to be viewed, send it behind.
Pressing [Alt] 4 [Tab] will bring the Jumpstart Controller back

to the foreground.

Misc: Marketing materials, slide presentations, Jumpstart credits,

licensing agreements, etc.
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Exit: Exits the application.

To give you an idea of the types of applications and sample media on Multimedia Jumpstart, look in the
following directories in the File Manager. They can also be viewed through the Jumpstart Controller and
Information Browser. A lot of the executables on this disc are source code. Most are designed with only
one task in mind. They may vary from simple animations to system-wide performance tests. Follow the
instructions below for a “brief” overview of where these little gems can be found.

d:\develpmt\sdk\vfw11.win\winvideo\setup.exe
Installs Video For Windows v1.1. If you have it already installed on your system, it will update the files.

Be sure to check the “playback only” box if you do not want the software development kit (SDK)
installed.

d:\develpmt\sdk\vidtest\vidtest.exe
Video For Windows performance test. Load an .avi file to your hard drive and compare the results with
your CD-ROM: This one is a must.

d:\develpmt\tools\convert\convert.exe

A cool program that converts file formats for Audio, MIDI, Palette or Image files. View the
documentation in the Information Browser for complete instructions.

d:\develpmt\tools\upfront\upfront.exe

The smallest icon bar you've seen that always stays on top. Great for quick access to the file manager or
launching executables.

d:\develpmt\tech art\truetype\truetype.doc
Detailed technical article of TrueType fonts.

d:\develpmt\source\roadshow\roadshow.exe
This directory has quite a few Javi, .bmp and .wav files,

d:\develpmt\source\rleapp\rle.exe
View the readme.txt for a description. Run the program and load “dog.r10”. Click on Play.

d:\develpmt\source\lava\lava.exe
Adijust the different variables and play around. The palette animation is a must!

d:\develpmt\source\cropdib\cropdib.exe
Crops Device Independent Bitmaps.

d:\develpmt\examples\infobrws\playviw.exe
Search here for all kinds of fun stuff! When you think you've found them all, look some more.

d:\samp_aps\intermed\aawin.exe
Autodesk Animation player. Load and play the .flc files on the CD-ROM drive.

d:\samp_aps\musicpn\go.exe
If you have kids, go get them! They’ll have fun with the wonderful exhibition of multimedia in
Lenny’s Music Toons.
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INSTRUCTIONS FOR INTERPLAY PRODUCTIONS

BATTI_E CH ESS ENHANCED

P NI IR N EeesieseentaEs iosisesn i s sestsencsesssesecessnsnesssssscsssssnssns

Now you can experience the mortal combat thrill of chess more intensely than
you’ve ever imagined. With bone-crunching battle sound effects, 3D animation
and stereo voices that bring your chess pieces to life, BATTLE CHESS is a must for
any MPC collection.

» Make sure you have 1 MB of free hard disk space for MPC installation.
{Animations can also be installed for increased performance if 32MB of free
hard disk space is available.)

» Insert Battle Chess into your CD-ROM drive.

» Under the Program Manager in Windows, select Run from the File menu.
» Type D:\mpcchess\setup where “D” is the letter of your CD-ROM drive.
» See readme.txt for DOS installation.

» Follow the on-screen instructions.

» Start the program by double-clicking the MPC Battle Chess icon.

)
A

(INBTRGCIONS] For the latest information about Battle Chess Enhanced, view the README.MPC file
on the CD-ROM. These instructions will assume for the most part that you have a
basic understanding of chess, i.e. movement and the object of the game.

For an informative multimedia presentation of each piece, see the Help Menu.

MOVING THE PIECES

To move a piece, just click on the square on which the piece is standing. Then choose the piece’s
destination by clicking on the square where you want the piece to move. The destination will flash if it is
a legal move. If you choose a piece and then decide you want to move a different piece, just click again
on the first piece’s square to deselect it. To castle, just move the King two squares to its destination, the
rook will know what to do on its own.

BATTLE CHESS MENUS

To make the menu bar appear, move the mouse pointer to the top of the screen. The menu bar will
automatically appear and then you can choose menu options in the usual Windows fashion.

File Menu Exit, Load, Save or start a New game.

Move Menu Setup Board: Lets you set up the pieces on the board however you wish, to test
strategies, play classic chess problems, or just give yourself another Queen if you
are behind.
Force Move: Stops the computer from thinking and forces it to make the best move
it has thought so far.
Take Back Move: If you make a mistake, use this option to take back one move on
one side, so you get another chance. You can Take Back up to 60 moves.
Replay Move: If you decide you liked a series of moves you just removed with
Take Back, use this option to undo the series of Take Backs one at a time. You can
Replay as many moves as you have taken back.
Suggest Move: This option asks Battle Chess for a hint.

Options Menu 3D Board/2D Board: Switches between a 2-dimensional and 3-dimensional board.

Difficulty: Only one level may be active at a time.

Red and Blue: Human, Computer or Modem. You can only select one of these
options at a time for each color.

| Support Options

INSTRUCTIONS FOR FANTAZIA

2000 FONTS

D R R T )

Dress up your documents with any font you could imagine. From bovine B’s to Swiss
cheese C’s, Fantazia Concepts has over 2000 unique fonts that will liven up every
document. All fonts are both True Type and Type 1 formats and a must for any word
processor.

This product requires no hard disk space.

Insert 2000 Fonts by Fantazia into your CD-ROM drive.

Select your CD-ROM drive from the DOS prompt. E.g., to select the “D” drive,
type D:<enter>.

Type fontmenu <enter>.

Please check the instruct.txt for complete instructions.

S

S
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Buy the book!

It makes viewing the fonts much easier.

To use this CD to it's potential and increase your understanding of how fonts work with one another,
take some time to look at advertisements and literature, notice how there are several different fonts on a
page as well as how different variations of each font are used to add emphasis. Be creative and have fun,
soon 2000 fonts just won't seem like enough.

2000 Fonts by Fantazia categorizes the fonts on the disc by style of print to make your search easier. If
you are looking for a script style of print, you can go to the script section and choose fonts there instead
of searching through all the fonts to look for the one script font you need. To make it even easier, no
more than 100 fonts are in one directory.

The file name Fantazia uses for any font describes its character. For example, the fonts in the script sec-
tion of the CD all start with “§8” for script. The number following the “§” is the Font number, and the let-
ters following the number are the styles and variations. Say you need Script 2 Extended. The filename
would be “S2E”. This also makes it easy for searches. Say you wanted to find any font on the CD-ROM
that is Script 2, you could do a search for “§2*.*”. If there is any contour, spotted, hollow, or any other
variety of this font, it will show up.

MAIN MENU

Menu Options: [Alt] + M Gets you to the “Menu” options. You can
Browse, Select, Edit Tags, Copy your selected

fonts, or clear the Tags you have make so far.

Browse: [F5] When in “Browse”, select the family of fonts
you wish to Browse first. When you select the
family that you wish to work with, you will get a

list of fonts contained in the current directory.

Select: [F6] From here all you need to do is type in the file
name you wish to search for and press [OK]. If
the file name is on the drive, the menu will
automatically bring up the “Work with Font”

dialog box to let you choose or view the font.

NOTE: Once you are done selecting fonts

from the “Work with Font” dialog box, just
select [CANCEL]. This will not untag the fonts,
it is just used once you are done selecting fonts.

Edit Tags: [F7] This is used for last minute changes to your
font list before you transfer the fonts to your

hard drive.

Copy Tags: [F8] Copies the fonts you have tagged so far. You
will be presented with a default directory. If you

wish to use a different directory, then type it in.

Clear Tags: [F9] This option is used to clear all the fonts you
have tagged so far. The menu does not automatically

clear the tagged fonts after you transfer them.

[Alt] + S Gets you the “Support” options. Allows you to



Settings Menu

Help Menu

Modem: These commands are only available when one color is set to “Modem” in
the “Options” menu. It is best to discuss ahead of time who is red and who is blue.
Who should call and who should receive.

Dial: Dials a phone number. Click on here if it was decided you would call.
Hang up: Hangs up your phone line.

Wait for Call: Lets another Battle Chess player call and connect. Click here if
it was decided you would receive the call.

Send Message: Sends a message to your opponent.

Music and Combat Sounds: Click <on>, click <off>.

Footsteps: Click <on>, click <off>.
Full Animation: This option will turn <on> or <off> all Battle Chess animation.

Animate Combats: This option enables combat animation, but turns <off>
walking animation.

Quickplay: This option turns <off> all Battle Chess animation.

Animation Control: Allows you to control various aspects of the animation frames.

Click on everything once.

Many systems do not have their MCI CD-Audio drivers automatically installed
when the CD-ROM is installed. This will appear as a MCI error of varying types.
To install it use the Drivers icon under the Control Panel in the Main program
group. Select [Add] and highlight [MCI] CD-Audio. Click [OK] and follow the
on-screen instructions,

Sales: (800) 428-8200
Fax: (714) 252-2820
Tech Support: (714) 553-6678

get Help tor the menu, Frint oif the registration
form or find out What is a Font?

Exit Menu [Alt] + X Exits the menu.

Close Window
HOW TO INSTALL FONTS IN MICROSOFT WINDOWS V3.1

The first step to installing True Type Fonts in Windows is to look for your Control Panel icon in the MAIN
program group. Double click to open the Control Panel and double click to open the Fonts icon. When
in Fonts, clicking on the [Add] button will bring up the [Add Fonts] dialog box which enables you to add

the fonts you wish. Select the proper drive and directory and up will come a list of fonts in that directory.
Click on the ones you want or click the [Select All] button. For detailed instructions regarding True Type
Fonts, please consult your MS Windows v3.1 manual.

[Alt] + F3 Closes the current window. E.g., Select Family, Select Font, etc.

»Keep under 300 fonts installed.

» Keep groups of fonts in separate directories, it will make Font
management much easier.

» It is not necessary to copy Fonts to the Windows System directory
for the fonts to work.

» Use a Font management program to organize your fonts.

» To save hard drive space, run the fonts off the CD-ROM.

3D 3D Fonts RHOLLOW Hollow Roman Fonts
BASIC Basic Fonts Directory 1 ROMAN Roman Fonts (Dir 1)
BASIC2 Basic Fonts Directory 2 ROMAN2 Roman Fonts (Dir 2)
BASIC3 Basic Fonts Directory 3 SCRIPT Script Fonts
BHOLLOW Hollow Basic Fonts SHADOW Shadowed Fonts
BORDERS Fonts with Borders (Boxed) SPIKED Spiked Fonts
CONTOUR Contour Fonts (White Border) SPOTTED Spotted Fonts
CRACKED Cracked Fonts STRIPED Striped Fonts (Dir 1)
DHOLLOW Digital Hollow Fonts STRIPED2 Striped Fonts (Dir 2)
DIGITAL Digital Fonts UHOLLOW Hollow Unique Fonts
GOTHIC Gothic Fonts UNIQUE Unique Fonts (Dir 1)
HAND Handwritten Fonts UNIQUE2 Unique Fonts (Dir 2)
HHOLLOW Hollow Handwritten Fonts WACKY Wacky Fonts (Dir 1)
HOLEY Fonts with Holes WACKY2 Wacky Fonts (Dir 2)
JAZZY Jazzy looking fonts (Dir 1) WACKY3 Wacky Fonts (Dir 3)
JAZZY2 Jazzy looking fonts (Dir 2) WARPED Warped Fonts (Dir 1)
JHOLLOW Hollow Jazzy Fonts WARPED2 Warped Fonts (Dir 2)
MANGLED Mangled Fonts (Dir 1) WAVEY Wavey Fonts
MANGLED2 Mangled Fonts (Dir 2)

Sales: (800) 951-0877

Fax: (216) 951-9241

Tech Support: (216) 951-5666
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INSTRUCTIONS FOR PIXEL PERFECT v3.0

HOME MEDICAL ADVISOR

R R R

HOME MEDICAL ADVISOR provides information on diseases, injuries, drugs, diets,
fitness, medical tests, household poisonings, and symptom analysis. The HOME
MEDICAL ADVISOR helps you diagnose problems and helps decide whether or not a
trip to the doctor is necessary. The user-friendly, interactive format asks a series of
questions, just like your doctor would, and analyzes symptoms to help you make
informed medical decisions.

»Make sure you have 5 MB of free hard disk space.
IS »Insert Home Medical Advisor into your CD-ROM drive.
‘5 » Under the Program Manager in Windows, select Run from the File menu.
> » Type D:\install.exe where “D” is the letter of your CD-ROM drive.

» Follow the on-screen instructions. The Home Medical Advisor Options screen will
allow you to set some specific characteristics of printing. Unless you are printing
landscape (sideways), we would recommend you just click [OK].

» Start the program by double-clicking the Home Medical Advisor icon.

» The Home Medical Advisor installation will create a text file in your Windows
directory called hma.ini. This file contains the information for printing and
can be altered using any simple text editor like Notebook.

» When printing, the Home Medical Advisor will also let you print the
document to a .txt file on the hard disk. This way you can bring it into your
favorite word processor. Simply click on the Print to File box after you have
selected the [Print] option and give the file a name.

KEYBOARD COMMANDS

[Alt] + S SYMptom file

[Altl + D DiSease file

[Alt] + 1 INJury file

[Alt] + P POlson file

[Alt] + T TEST file

[Alt] + R Rx Drug file

[Alt] + H Health & Diet file

[Tab] Scrolls through buttons.

Arrow keys  Navigate the list when the [Tab] key is highlighting that area.

GENERAL PROGRAM INFORMATION

SYMPTOM FILE [Alt] + S

The Symptom file is a listing of 70 of the most common CHIEF COMPLAINTS. Each one of these CHIEF
COMPLAINTS can represent a number of diagnostic possibilities. A CHIEF COMPLAINT is the key
Symptom. For example, a patient who has pneumonia complains of breathing difficulty. Associated with
the breathing difficulty may be a cough, fever, chills, and nausea. None of these symptoms are as serious
to the patient as breathing difficulty. The patient has targeted their CHIEF COMPLAINT as breathing
difficulty.

For each CHIEF COMPLAINT there will be a short introduction screen explaining the symptom. This will
be followed by the DIFFERENTIAL DIAGNOSIS MENU. This is a listing of diseases which can manifest
with the CHIEF COMPLAINT. Because it is a menu, you can reference each diagnostic possibility direct-
ly, bypassing the computer guided Question and Answer session. The easy to use Question & Answer
format can formulate up to 400 potential diagnoses through the use of over 1,400 questions with the aid
of over 600 color VGA illustrations.

Try investigating your problem from several different angles or
CHIEF COMPLAINT's.

INSTRUCTIONS FOR SIERRA ON-LINE

SPACE QUEST IV

L R

SPACE QUEST IV multimedia must be experienced to be believed. Ever hear an alien
talk? Ever hear a sniveling space hero or a giant mutant sea slug? Well, you're
about to when you join ROGER WILCO and TIME RIPPERS on a fantastic journey
through the future. Stumble through time and space, staying one step ahead of the
savage Sequel Police. They’re out to make sure this is the last SPACE QUEST ever!

» Make sure you have 6 MB of free hard disk space.
» Insert Space Quest IV into your CD-ROM drive.
» Under the Program Manager in Windows, select Run from the File menu.
» Type D:\setup where “D” is the letter of your CD-ROM drive.
NOTE: D:\install.exe is for DOS installation.
» Follow the on-screen instructions.
» Start the program by double-clicking the Space Quest IV icon.

You may play your Space Quest IV CD directly from the CD by typing SQ4
[parameter] from your CD-ROM drive where [parameter] is one of the following
configurations:

SB = SoundBlaster sound & audio

MT = MT-32 sound/SoundBlaster audio

PRO = ProAudio sound & audio

STD = Standard PC speaker sound/SoundBlaster audio
THN= ThunderBoard sound & audio

GEN = General MIDI sound/SoundBlaster audio

This option will not write to your hard drive so you will not be able to save the
game. You may experience a general slowdown due to the significant amount of
CD-ROM access. This will be more noticeable on slower CD ROM drives and
386 based systems.

Walk Icon

Look Icon

Action Icon

Talk Icon
Smell Icon
Taste Icon
Item Icon

Inventory Icon

Control Icon

To open the icon bar, press [ESC] or move the cursor all the way to the top of your
screen. The icon bar contains the icons that can be selected to execute the
command choices available to you. They are listed below. Some icons will have a
menu of choices. Use the [Tab] key, mouse or joystick to move between choices
within an icon menu.

Choose Walk when you want to move the character from place to place on the
screen. A walking character will move until it encounters an obstacle in its path,
then stop.

Choose Look when you want to have the character look at something on screen.
Pictured as a hand, the Action icon will perform an action on an object. E.g.,
getting a drink from a pond, jumping onto a rock, etc. The necessary action will
be performed automatically.

Choose Talk when you want to initiate a conversation between game characters.
Choose Smell when you want to take a good, hearty whiff of something.

Choose Taste when you want to try tasting something.

The Item icon shows the last inventory item you selected. Choose Item when you
want to see or use the object.

Pictured as a purse, choose Inventory when you want to see and select from the
items you are currently carrying. You can use the Look or Action icons to perform
tasks within the Inventory screen. E.g., putting jewels you found into a pouch you
found.

The Control icon allows you to adjust the speed, volume and game detail. If your
game is running too slowly, you may want to adjust the Game Detail to eliminate
non-essential animation. SAVE, RESTORE & QUIT functions are also accessed via
the Control icon.




DISEASE FILE [Alt] + D

This is an alphabetical index of over 500 diseases with a complete discussion of their causes, common
symptom presentations, physician evaluation and treatment. This file also includes a special section on
children’s health.

INJURY FILE [Alt] + 1
This is an alphabetical listing of over 200 common injuries to the body. This file is also indexed by body
parts.

POISON FILE [Alt] + P
This listing contains over 500 common household poisons and exposures. This file will tell you what to
do and who to see for a variety of plant, medicinal, and household product ingestion’s.

TEST FILE [Alt] + T

In no other area has medicine been more progressive than the field of diagnostic testing. This section
provides an alphabetical listing of more than 160 of the most widely used medical tests. Each section
will explain why the test is used, its diagnostic limitations, known risks, and possible complications.

Rx DRUG FILE [Alt] + R

The list of pharmaceutical agents is exhaustive and growing every year. In this file, you will find a listing
of over 2,400 medications both non-prescription and prescription, with information.en their uses, poten-
tial drug side effects, and drug interactions. All trade name medications are enclosed by (parenthesis) and
are included for the purpose of increasing consumer understanding of all available generic and non-
generic medications.

HEALTH & DIET [Alt] + H
Includes information on vitamins, minerals, nutrition, health, travel tips, safety and first aid, life-style
health risks, travel vaccinations, weight loss and special diets.

GLOSSARY BUTTON
Brings up a complete listing of all Glossary Words.

HOT KEYS AND GLOSSARY WORDS

Highlighted text will indicate either a Glossary Word (yellow) or Hot Key (green) that can be chosen by
clicking on that item. The cursor must change to a hand (pointing finger) before you can jump to a Hot
Key destination or define a Glossary Word.

USING THE SCAN FEATURE

The Scan feature allows you to rapidly find a particular topic or access all sections of the database that
apply to a particular part of the body. For example, if you enter the word HEART, the Scan feature will
find all topics in the knowledge base that pertain to the HEART. If you Scan for a topic that has no
match, try entering just part of the word rather than the entire word. If you do not find what you are look-
ing for with the Scan, try looking in the Glossary.

Sales: (800) 788-2099
Fax: (407) 777-0323
Tech: D:\HMA.TXT

Information lcon  Pictured as a question mark, choose Information when you need to be reminded

what the various icons do in the game.

OBJECT CURSORS

Each item in your inventory has a special Object cursor. These can be used to perform game actions with
your inventory items. Follow these steps:

» Choose the Inventory icon from the icon bar.

» Move the arrow to the inventory item you want to use and click.

» The cursor will change to look like the item you have selected.

» Click on “OK” and you will exit back to the game.

» Move the Object cursor to the place on screen where you want to use

the inventory item and click.

CHEAT NOTES

Space Piston Safety Tip: AVOID THE CYBORGS!
Continue reading ONLY if you have trouble getting started playing Space Quest.

As you arrive on the streets of Xenon, click the EYE cursor on various locations on the screen to learn
about your surroundings. Walk one screen East and click the HAND cursor on the rope in the lower right
side of the screen. Avoid the Cyborg if he should appear. Walk between the red columns on the upper
right side of the screen. Select the rope from your Inventory window and click the ROPE cursor on the
ground. Wait for the bunny to walk into the noose, and click the HAND cursor on the rope. Walk two
screens East. A Skimmer is parked on the street. Click the EYE cursor on the skimmer. Click the HAND
cursor on the skimmer to search it. Click the HAND cursor on the glove box to open it, and click again
to take the PocketPal inside. Walk one screen North. Click the EYE cursor on the hole in the side of the
tank. Now would be a really good time to SAVE YOUR GAME!! Click the HAND on the unstable
ordnance to take it. Walk two screens West, to the opposite street corner. Click the HAND cursor on
the sewer grates, until you find one you can climb into. After you explode, restore your game and
DON'T take the unstable ordnance. Return to the sewer grate, descend below the city, and enjoy the
rest of the game!

» In order to save games, you must install Space Quest IV to your hard drive.
» Save your game frequently. You never know when you might get killed!

» On a two or three button mouse, the right button will cycle through available
CUrsors.

» If you wish to pause the game, select the Controls Icon from the icon bar.
The control panel states the game is paused. The game will pause until you

select PLAY to resume.
Sales (800) 757-7707
Tech Support (206) 644-4343
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